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1.  Introduction

This guide provides an overview and describes the
basic skills and terminology required to operate the
following Elixir applications:

Elixir Desktop, a Windows-based user interface
from which you can easily launch the Elixir Forms
Editor.  The Elixir Desktop also enables quick ac-
cess to Elixir converters, which convert form, font,
 and graphics files between Elixir- and other for-
mats.  You can edit  Eixir-format form files using
the Elixir Forms Editor and convert the files  back
to the original or another format using the Elixir
Desktop.

ElixirForm is a Windows-based WYSIWYG forms
creation package you can use to create or edit
Elixir-format forms.  You can then convert them to
other format  forms using the Elixir Desktop.

You can operate the ElixirFont and ElixirGraphics
applications if you have them installed.

Each Elixir application has a user guide  that you can
refer to for more detailed information.  
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Customer support

If you have purchased your Elixir product directly from
Elixir Technologies then contact the support center for
your region at the number listed below.

North and South America: 
+1  805 641 5900 ext. 3

Asia Pacific 
+92 (0) 51 206182

Europe  
+420 2 2431 13877

The U.S.A. Elixir Customer Support Center provides
telephone technical assistance for Elixir users Monday
through Friday from 6:30 a.m. to 5:00 p.m.  Pacific
Standard Time.

If you have any problems running or using Elixir Print-
Driver or associated Elixir applications, contact the
support center in your region for help.  An Elixir prod-
uct specialist will answer your call and ask for the fol-
lowing information:

your name, organization, telephone number and
address.

the name and version number of the Elixir
application.

a complete description of the problem, including
any error messages displayed on your monitor or
printed at your printer.

You can contact Elixir support  by accessing the Elixir
World Wide Web page (and selecting [Contact Sup-
port]) at http://www.elixir.com.  Please complete the
question form.

INTRODUCTION
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Elixir Web site support

The Elixir Web site at http://www.elixir.com offers the
following resources:

Raise a question for Elixir Support.

Find answers in the list of Frequently Asked
Questions.

Review the latest Tips and Techniques for in-
creasing productivity using Elixir software.

Download new releases and the latest patches.

View Release Notes for the latest available
features.

Learn in the user newsgroup how others are us-
ing Elixir products.

Sign up for an Elixir Learning Program.

Elixir training

Elixir Technologies Corporation offers training for the
complete range of our Windows-based family of soft-
ware products. For more information, contact:

     Elixir Learning

(805) 641-5900 ext. 6

INTRODUCTION
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System requirements

This section lists the hardware and software require-
ments for running the Elixir Desktop and other Elixir
applications.

Hardware

Recommended PC configuration: Pentium (or
100% compatible), with at least 133 MHz processor
(or the fastest commercially available processor); 32
MB RAM, 500+ MB hard drive, one CD-ROM drive.

Additional hardware requirements:

any monitor with driver software supporting Win-
dows in VGA, SVGA, or Sigma LaserView.

any Windows compatible mouse.

any PC-to-mainframe or communications board
that supports binary file transfers (such as IBM
PC3270, IRMA FT/3270, or AS/400 PC communi-
cations packages).

One or more of the following peripheral devices:

AFP compatible printers.

HP LaserJet II or compatible PCL 4 printer.

digital scanner and associated software with
ability to  create .PCX or .TIF images at 300
or 300 dpi.

Software

Software requirements: Microsoft Windows 95, Win-
dows 98, or Windows NT 4.0 or later. 

While we make every effort to ensure the proper op-
eration of our software, some problems cannot be re-
solved due to differences in the operating systems.

INTRODUCTION
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Who should use this guide

This guide serves users needing first-time or ongoing
reference information about the Elixir Forms Editor
Desktop. 

Users should already be familiar with Microsoft Win-
dows operations, printer and font management opera-
tions and PC peripherals, and have access to refer-
ence manuals for related PC software and hardware.

Conventions

Most of the following conventions are the same or
similar to Windows conventions.

display conventions

typographical conventions

mouse operations

Display conventions

The Elixir Desktop, ElixirForm, ElixirFont and Elix-
irImage all adhere to Microsoft Windows conventions
for using menus, menu commands, dialog boxes,
command buttons, icons and mouse.  See your Win-
dows manual for more information.

Typographical conventions

The following typographical conventions are used
throughout this guide and other Elixir product guides.

Keystrokes are shown enclosed in < > (angle
brackets). For example:  

<Enter>

INTRODUCTION
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Key combinations are denoted by a plus sign be-
tween keys. For example: 

<Shift> + <F1> indicates to simultaneously press
the <Shift> and the <F1> keys.

Menu titles are shown in bold. Menu options are
enclosed in [ ] (square brackets). For example:

Select [New] from the File menu.

Commands, options, actions, and parameters
that require description are shown in bold fol-
lowed on the next line by the description.  For ex-
ample:

Delete
Deletes the selected files.

Steps in a procedure are shown in numbered bold
paragraphs.  For example:

1. At the prompt, enter the file name and
extension.

Comments relating to a step (such as this para-
graph) are shown in regular text following the bold
paragraph.

Commands you enter at the DOS prompt are
shown in larger text.  Within DOS commands,
variable names and keys you press are shown in
italics.  For example: 

CD \ELIXIR <Enter> 

Mouse operations

You can perform most operations in Elixir applications
by using the mouse.  The terminology is similar to
other Windows based applications.

Mouse operations are performed using the left or right
mouse buttons, depending on the specific task.

INTRODUCTION
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The following mouse related terms are used in this
guide:

click
to momentarily press and release the left mouse but-
ton once.  A right mouse button click is specified
where necessary.  For example,

Click on the right mouse button to finish entering text.

double-click
to click the left mouse button twice in rapid
succession.

drag
to click and hold the mouse on an item and move the
item with the mouse.

drag and drop
to drag an item as above, then release the mouse but-
ton, once the item is positioned over a the area.  If the
selected object is a file and the destination is a direc-
tory, the file copies to the directory.

object
a selectable item on the screen.

open
to point and double-click on an icon -- the effect of this
operation depends on the icon.

point
to move the mouse to position the screen pointer on
an area of the screen.

select
to point to an object and click the mouse -- this usually
highlights the object.

<Alt>click
to hold down the <Alt> key while pressing the left
mouse button -- this allows you to select a range of
files in a window.

INTRODUCTION
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<Ctrl>click
to hold down the <Ctrl> key while pressing the left
mouse button -- this allows you to select individual
files from a group in a window.

<Shift>click
to hold down the <Shift> key while clicking the mouse
-- this allows you to select more than one object at a
time. 

On-line Help

Elixir software uses the Microsoft Windows Help pro-
gram to provide on-line Help for all functions.

For more information about Windows Help, select the
[How to Use Help] option in the Help menu, or see
your Microsoft Windows documentation.

The Help files included with your Elixir software in-
clude graphics created using screen drivers with large
fonts.  If you use a screen driver with small fonts, the
Help file graphics may not display clearly.  For opti-
mum graphics display, use a screen driver with large
fonts.

You can display on-line Help in the following ways:

Bubble Help
Click on an icon with the right mouse button to view its
properties (if applicable) or to display "bubble help."
Bubble help is a short description of the icon function
that displays in a bubble extending from the icon.  

Quick Help
Enable the quick function by selecting the quick help
option in the Usage Switches (or Preferences -- for
ElixirImage) dialog box.  When you move the screen
pointer over an icon on the screen, a short description
of the icon function displays in the message area of
the screen.  During certain operations a message
about the function you are performing also displays in
the message area.  To see these operational mes-
sages, disable quick help.
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Context sensitive Help
To use this function, click on an icon and press <F1>.
If available, the appropriate Help topic displays.  If no
specific topic is available, the Help table of contents
displays.

Help menu
Select [Help] from the top pull-down menu and choose
one of the displayed topics.

Dialog box Help
Click on the [Help] button in a dialog box to view an
associated Help topic.  Under Windows 95 and Win-
dows NT, right-click on a dialog box option to display
an associated Help topic.

Help pop-ups and jumps
Within Help topic text, words or phrases underlined in
green are pop-ups or jumps.  When you click on a
pop-up topic, a box displays within the current Help
topic with additional information.  When you click on a
jump, a different, associated Help topic displays.

Help hypergraphics
Hypergraphics are special graphics within Help files
that contain "hot spots".  Hot spots are either pop-up
topics or jumps. Hypergraphics in Elixir Help are most
commonly dialog boxes with option hot spots (pop-up
definitions), toolboxes with tool hot spots (topic
jumps), and menus with option hot spots (topic jumps
or pop-up definitions).  

Move the cursor over a hypergraphic until a hand dis-
plays, then click on this hot spot to display a pop-up
topic, or a "jump".  To close a pop-up topic, click the
mouse button.  To return to the original Help topic
from a jump, click on <Back> in the Help file menu. 

INTRODUCTION
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Using Online documentation

This section describes how to use PDF online docu-
mentation, including navigating through the online
guides and printing the guides.  Acrobat Reader is
provided with the online documentation.  Information
about using the Acrobat Exchange program is in-
cluded for users who have licenses for that program.

Accessing online guides

The PDF online documentation is copied to the
drive:\Elixir\help\pdf directory during the installation of
Elixir Suite for AFP.  If you didn't choose to copy the
PDF online documentation during the installation, you
can view a complete list of the files by clicking on the
Windows [Start] button and selecting Programs>Elixir
Applications>Elixir Suite for AFP. Once the application
is launched, click on the Help menu and select Re-
lease Notes.  Wordpad displays a current list of sup-
porting documents and the directories where they can
be found on CD-ROM.

When the appropriate PDF file is accessed the Acro-
bat Reader program is launched and the List of Online
Guides is displayed.  Click on a guide to view its table
of contents and jump to individual chapters. 

The following list of PDF files and associated docu-
ment names are installed in the drive:\Elixir\help\pdf
directory.

StartAFP.pdf - Getting Started User Guide

DeskAFP.pdf - Elixir Desktop and Converters
for AFP User Guide

FormAFP.pdf - ElixirForm User Guide

FontAFP.pdf - ElixirFont User Guide

ImageAFP.pdf - ElixirImage User Guide

PdAFP.pdf - Elixir PrintDriver for AFP User
Guide
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PdNT.pdf - Elixir PrintDriver for NT User
Guide

AppAFP.pdf - Elixir AppBuilder for AFP User
Guide

Transfmr.pdf - Elixir Transformer Suite User
Guide

Viewer.pdf - ElixirViewer User Guide

Elxscan.pdf - ElixiScan User Guide

Navigating in online guides

After loading a PDF document in Acrobat Reader or
Exchange program (as described above), you can
navigate through the online guide by clicking on the
following:  

TOC chapter titles - jumps to the beginning of the
chapter indicated.

[Next Page] or [Previous Page] in the Toolbar - jumps
to the next or previous page of the online guide (alter-
natively, you can use the <Page Up> and <Page
Down> keys).

[Go Back] in the Toolbar - returns to your previous
location.

[First Page] in the Toolbar - returns to the opening
screen of the online guide.

Word find

This option finds a key word or phrase in the current
document.

To use Word Find in a document:

1. Click on the [Find] icon in the Toolbar.

2. Enter the desired search text and click on
[Find].

INTRODUCTION
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The Acrobat Find dialog box closes and the first
occurrence of the text is highlighted.

3. To find more occurrences of the same text,
click on the [Find] icon in the Toolbar and
then click on [Find Again] in the Find dialog
box.

Page scrolling

You can move a document on the screen to view por-
tions of it not visible in the window, or read a docu-
ment which contains article threads by clicking the
mouse to scroll through the document without using
the scroll bar.

To move a document on the screen for viewing (func-
tional only when the document displays wider than the
document window):

1. Click on the [Hand] icon in the Toolbar.

2. Hold down the mouse button and drag the
cursor in the desired direction.

To follow the flow of text in a document that contains
article threads (automatic text flows):

1. Click on the [Hand] icon in the Toolbar.

2. If the document contains article threads, a
“down” arrow displays on the Hand icon.

3. Position the hand-shaped cursor over a
paragraph and click on the paragraph to begin
reading. 

4. Continue clicking to follow the flow of text.

Zoom in/out

To magnify the size of the page display, click on the
Zoom icon in the Toolbar, then click in the Work area.
Each click resizes the view by a factor of two.
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To reduce the size of the page display, click on the
Zoom icon in the Toolbar, then hold down the <Ctrl>
key and click in the Work area. 

You can also click on the [%] button at the bottom of
the screen and select a zoom percentage from the
pop-up list.

Printing online guides

You can print individual chapters or an entire book to
PostScript or HP printers:

1. Open the file.

2. Select File>Print.

The Print dialog box displays.

3. Select your printing options and click on [OK].

Organization of this guide

Chapter 1, "Introduction," is an overview of Elixir soft-
ware and documentation; and the display, typographi-
cal, and mouse conventions used for Elixir software
and documentation.  This chapter also provides hard-
ware, software, and memory requirements for install-
ing Elixir software.

Chapter 2, "Installation," describes how to install Elixir
software.

Chapter 3, "Desktop basics," provides an overview of
the Elixir Desktop and instructions on how to perform
basic Desktop operations.

Chapter 4, "ElixirForm basics," provides an overview
of ElixirForm and instructions on how to perform basic
ElixirForm operations.

INTRODUCTION
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Starting Elixir applications

This section assumes you have already installed the
Elixir Desktop (see the "Installation" chapter for more
information).

This section describes how to start the Elixir Desktop
and the Elixir Forms Editor.

To start the Elixir Desktop, open the Elixir icon in the
Program Manager Elixir Applications window.

The Elixir Desktop displays.

Figure 1-1.  Elixir Desktop window

Note:  If you are using a monochrome monitor and
have difficulty reading the title bar text, select [Usage
Switches] from the System menu.  Then, in the Us-
age Switches dialog box, select [Monochrome
Monitor].

To start ElixirForm, double-click on the ElixirForm icon
on the Elixir Desktop.

INTRODUCTION

1-14 ELIXIR TECHNOLOGIES CORPORATION



Sub-window menus

All Elixir applications offer additional functionality to
normal Windows operations by allowing functions
such as pull-down menus in sub-windows (or "child"
windows).

The following figure displays a sub-window menu se-
lection from the Elixir Desktop.

Figure 1-2.  Sub-window menu  

INTRODUCTION

ELIXIR FORMS EDITOR GETTING STARTED GUIDE 1-15



Exiting Elixir applications

This section describes how to exit the Elixir Desktop
and the Elixir Forms Editor.

To exit the Elixir Desktop or Elixir Forms Editor:

Double-click on the Close button at the top left of
any Elixir application.

Press <Alt> + <F4>.

Press <Alt> + <X>.

From the File menu, select [Exit].  

Notes and cautions

Elixir user guides contain a "Notes and cautions" sec-
tion.  Before using an Elixir application, we recom-
mend that you read the "Notes and cautions" section
applicable to your application.  You can also access
this information by viewing the "What's new in this re-
lease" section of Elixir on-line help.
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2.  Installation

This chapter describes procedures for installing the
Elixir Desktop for the first time, and for installing the
Elixir Desktop over a previous version.

Before installation

Read the notes supplied with the Elixir installation pro-
gram before installing or reinstalling the Elixir
software.

Complete the software licensing process (See the
"Product Registration" section).   

All Elixir applications described in this guide are
installed using the supplied CD-ROM. 

First time installation (of a Desktop application)
requires at least 26 MB of free space on your
hard disk drive.  Selecting multiple applications
will require additional disk space.  Reinstallation
requires less disk space as the installation proce-
dure overwrites existing Elixir application files.  

Each time you reinstall Elixir software, you over-
write existing program files and utilities with new
ones.  You should select backup files when
reinstalling.

To avoid any possible conflicts, exit all other ap-
plications before installing Elixir software.

If you want to abort installation at any time during
the process, click on the [Cancel] button from the
install screen or press the <Esc> key.  You will be
prompted to abort.
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Release notes

Release notes appear at the beginning of the Elixir
software install process, so that you can review each
entry before performing the complete installation.
Once the software is installed, release notes can be
accessed from the Help menu of the application.  Re-
lease notes are formatted for viewing in Notepad or
Wordpad.  They have a txt file extension and are
found in the drive:\ELIXIR \RELNOTES directory.

Product Registration

Elixir products no longer require ElixiKey hardware de-
vices attached to your parallel port.  Elixir products
now utilize soft key technology.  This new licensing
process validates your license agreement with Elixir
and places a file (password.epw if an Elixir customer,
or License.dat if a Xerox customer) on your
workstation.

Version 4.00 implements Elixir's new licensing proc-
ess and discontinues use of the current hard keys.  All
customers must register/re-register software licen-
se(s) by using the Elixir registration program provided
with the software. 

Each product installed is assigned to a specific pc.
This pc number, your customer number, and pass-
word are required.  This information is provided when
you purchase Elixir software or when you upgrade to
version 4.00 of Elixir products.

If you are an Elixir customer, registration can be com-
pleted automatically if you have an internet connection
on your workstation.  If you are a Xerox customer you
must contact Xerox to register your products.

This section describes the registration process for
those customers who have purchased their Elixir
products form Elixir Technologies.

INSTALLATION
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The following scenarios describe the  registration
process for Elixir  customers.  Xerox Corporation will
provide a separate document that describes  register-
ing your products with Xerox.

you are a new customer and will use Soft Key
registration

you are an existing customer and will change to
Soft Key registration 

Elixir Product Registration screen

Make your selections according to your needs and go
to the appropriate section for further procedures.

Figure 2-1.  Elixir Product Registration screen

INSTALLATION
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Using the internet 

You can register and download all registration files via
the Elixir Product Registration program.  There are
two ways to register your products using  the Internet:

down load the product registration file directly to
the Elixir PC via the Internet (see "Registering as
a new customer via the internet")

download the product registration file to another
machine and move it to the Elixir PC (see "Down-
loading via the internet to a non-Elixir PC")

Registering as a new customer via the internet 

You will receive a "Customer Activation Letter" with
your product(s) ordered.  The registration process
should be completed before installing your software.
The installation CD will launch and install the Registra-
tion Program. 

To install the registration program on your Elixir PC: 

1. In the Software Registration screen, click on
[Next].

2. Select the drive and click on [Next].

3. In the Start Registration Process screen, click
on [Install].

The password file will be installed and your sys-
tem configured.

To complete registration:

1. In the Elixir Product Registration "Welcome"
screen, select [Next].

Your machine serial number displays.

2. Enter your customer number (from Activation
Letter), then click on [Next].

INSTALLATION
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3. Enter your password and the PC number you
want to register, then click on [Next]. 

4. Select [Prepare and download my initial
product license registration.  This workstation
or another pc is connected to the internet]
from the Registration Option menu, then click
on [Next]. 

5. In the Download Password screen, click on
[Yes].  

The system displays your customer information
and you must verify that it is correct.

6. When the screen displays the registration
information, click on [Save].  You may also
print this screen for reference or to send to
Elixir.

The application installation process will begin, see the
"Installation" section.

Downloading via the internet to a non-Elixir PC  

You will receive a "Customer Activation Letter" with
your product(s) ordered.  The registration process
should be completed before installing your software.
The installation CD will launch and install the Registra-
tion Program. 

To install the registration program on your Elixir PC: 

1. In the Software Registration screen, click on
[Next].

2. Select the drive and click on [Next].

3. In the Start Registration Process screen, click
on [Install].

The password file will be installed and your sys-
tem configured.

INSTALLATION
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To complete registration:

1. In the Elixir Product Registration "Welcome"
screen, select [Next].

Your machine serial number displays.

2. Enter your customer number (from Activation
Letter), then click on [Next].

3. Enter your password and the PC number you
want to register, then click on [Next]. 

4. Select [Prepare and download my initial
product license registration.  This workstation
or another pc is connected to the internet]
from the Registration Option menu, then click
on [Next]. 

5. In the Download Password screen, click on
[No].  

6. In the How to Contact Elixir screen, click on
[Print] and take the printout to the pc
connected to the internet.

7. Access the Elixir Web site at
http:\\www.elixir.com. and click on [Product
Registration].

8. In the Customer Information screen, enter
your Customer Number and Password, then
click on [Submit Form].

9. In the Elixir Customer Menu, click on
[Download a New License File].

10. In the Customer Information screen, enter
your PC Number and Machine Serial Number,
then click on [Submit Form].

11. In the Elixir Technologies screen, click on
[Click here to download your password].

12. Save the password.epw file to diskette and
copy it to your Elixir PC in the \ELIXIR
directory. 
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The application installation process will begin, see the
"Installation" section.

Contacting Elixir (no internet connection) 

If you have no internet access at your site you must
contact Elixir and provide the serial number of the pc
where you will install the Elixir software.  Elixir will pro-
vide a registration file (password.epw) that you must
copy to the Elixir pc.

Copy the password.epw file to \Elixir and start the
installation.  

Select [Prepare my initial product license registration.
This workstation is not connected to the Internet] from
the Registration Option menu, then click on [Next].

The application installation process will begin, see the
"Installation" section.

Soft key customers running Windows for Workgroups 3.1 or 3.11 

Since Windows 3.1/3.11 does not have internet capa-
bility, you must contact Elixir to obtain your password
file.   After installation of Elixir software, the installation
program verifies that the operating system is 3.1 or
3.11, runs passwd16.exe, and provides your machine
serial number. 

To complete registration: 

1. Enter your customer number, password and
PC number, then print out a copy of this
screen. 

2. Fax, email, or mail Elixir the display printout.
Elixir will generate a password.epw file and
send it to you on diskette. 

3. Load the password.epw file in the \ELIXIR
directory. 

The application installation process will begin, see the
"Installation" section.

INSTALLATION
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Installation

This section describes how to install Elixir software
using the [Full] and [Custom] options. Installing addi-
tional Elixir applications to an existing version is also
explained.

Note: The software registration process must be com-
pleted (See the "Product Registration" section).

For information about starting Elixir applications after
installation, refer to the "Introduction" chapter. 

During installation, the log file,  XWIN.log, is created in
the drive:\Elixir directory.  XWIN.log contains a list of
all directories and files copied or created, including in-
formation pertinent to the installation.  It can be ac-
cessed, using Notepad or Wordpad. 

If you have any problems running Elixir software after
installation, refer to the "Troubleshooting" section of
the Elixir Getting Started Guide for more information.

Installing Elixir applications

Elixir provides a simple, interactive procedure for in-
stalling Elixir applications.  

During installation you can select [Full] or [Custom]
installation.

Selecting a [Full] installs all Elixir applications and
demonstration files on the same drive.  If you
have a previous version of Elixir software, this op-
tion overwrites the existing version.

Selecting a [Custom] installation allows you to
choose the Elixir applications and options (such
as Elixir demonstration files) you want installed,
as well as where you want certain options in-
stalled.  For example, You may want the PDF
documentation in a different directory than the ap-
plication.

INSTALLATION
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You can also install Elixir program files (required
to run Elixir), and data files (files that you create
or files such as the Elixir demonstration files), in
separate drives and directories.

Full installation

To begin installation:

You can quit installation at any time, by pressing the
<Esc> key. 

1. Close all active applications.

2. Insert the CD in your CD-ROM drive.

3. In the "Welcome" screen, click on [Next].

The Release Notes? screen displays.

4. Select [Read Release Notes Now] to display
them in Wordpad (or Notepad), or click on
[Next] to proceed with the installation.

The Product Selection screen displays.

5. Select the applications you want to install and
click on [Next].

The Selected Products screen displays.

6. Verify the listed applications and click on
[Next].  If you need to delete or add to the list,
click on [Back] and reselect.

7. Verify your user information and click on
[Next].

8. In the Select Install Type screen, select [Full]
and click on [Next].

9. Select the drive on which you want Elixir
software installed, then click on [Next]. 

10. Select the Programs Folder in which you want
Elixir software installed (Elixir Applications is
the default), then click on [Next]. 

INSTALLATION
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11. In the Backup Replaced Files screen,  click on
[Yes], if you want to make back-up copies of
all files replaced during installation and select
the directory where the back-up files will be
placed. Then click on [Next].

12. In the Start Copying Files screen, click on
[Install].

Installation begins.

13. Once installation is complete, click on [Exit
Installer].

Custom installation

To begin installation:

You can quit installation at any time, by pressing the
<Esc> key. 

1. Close all active applications.

2. Insert the CD in your CD-ROM drive.

3. In the "Welcome" screen, click on [Next].

The Release Notes? screen displays.

4. Select [Read Release Notes Now] to display
them in Wordpad (or Notepad), or click on
[Next] to proceed with the installation.

The Product Selection screen displays.

5. Select the applications you want to install and
click on [Next].

The Selected Products screen displays.

6. Verify the listed applications and click on
[Next].  If you need to delete or add to the list,
click on [Back] and reselect.

7. Verify your user information and click on
[Next].
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8. In the Select Install Type screen, select
[Custom] and click on [Next].

9. In the Configuration Only? screen:

Selecting [Yes] allows you to load Configura-
tion, Program, and Data files into  any resi-
dent directory.

Selecting [No] allows you to deselect options
you do not wish installed.

10. Select the Programs Folder in which you want
Elixir software installed (Elixir Applications is
the default), then click on [Next]. 

11. In the Backup Replaced Files screen,  click on
[Yes], if you want to make back-up copies of
all files replaced during installation and select
the directory where the back-up files will be
placed. Then click on [Next].

12. In the Start Copying Files screen, click on
[Install].

Installation begins.

13. Once installation is complete, click on [Exit
Installer].

Adding applications

If you did not install all of the Elixir options while per-
forming the Custom installation procedure, you can do
so at any time by following the steps described in the
"Custom installation" section of this chapter.

Adding newly licensed applications

If you purchase additional Elixir products,  Elixir will
update your password file.  You can access the Prod-
uct Registration program from your program group
and re-download your initial product registration pass-
word file to activate your new products.

INSTALLATION
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3.  Desktop basics

This chapter describes the Elixir Desktop and basic
Elixir Desktop operations.

For information on additional Elixir Desktop operations
see the Elixir Forms Editor Desktop User Guide.

Overview

The Elixir Desktop is a Windows-based operating en-
vironment for the Elixir Forms Editor product.  The
Elixir Desktop enables you to invoke and use the Elixir
Forms Editor application.  You can also operate the
ElixirFont and ElixirGraphics applications form the
Elixir Desktop if you have them installed.

Though primarily designed for use with Elixir applica-
tions, the Elixir Desktop complements standard Win-
dows operations by adding an additional environment
for performing PC activities.

Many productivity-enhancing features are built into the
Elixir Desktop that allow you to perform actions such
as:

viewing files in associated applications using the
Desktop Viewer

accessing your entire DOS directory structure us-
ing the User Files icon

running batch files or executables from the
Dispatcher

defining icons for any DOS-based application
such as word processors, desktop publishers,
spreadsheets, and other applications that you can
start directly from the Desktop
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linking files to applications, enabling you to start
an application and load a file in one step

running DOS commands

converting files by copying files to the Converter
icon.

Desktop layout

The Elixir Desktop shown in the following figure con-
tains the following main features:

the Elixir Desktop menu bar

the Message area

a number of icons.

Figure 3-1.  Desktop window  
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The Elixir Desktop menu bar allows you to access the
following pull down menus:

File
System
Special
DOS
Window 
Help

You can pull down a menu in one of the following
ways:

Click on the menu.

Press the <Alt> key along with the underlined let-
ter in the menu.

The Message area displays information about opera-
tions you perform.  Error messages and warnings, if
any, also display in this area.

Icons

The Elixir Desktop displays a number of icons below
the menu bar and message area.  Each Desktop icon
represents either an application, a folder, a device
connected to your PC, or a utility that allows you to
perform certain tasks.  The following sections briefly
describe each icon.

Generally, the shape, name, and appearance of an
icon indicates its type and the action it allows you to
perform.

Note that you cannot move Desktop icons.

Elixir folder icons

The Elixir folder icons (or Elixir folders) represent spe-
cific DOS directories.  You access files and copy files
into and out of these icons when you convert files
from one format to another format.  See the “Elixir
folder structure” section of this chapter for more infor-
mation on Elixir folders.
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ELIXIR FORMS EDITOR GETTING STARTED GUIDE 3-3



Forms folder

The Forms folder represents the
drive:\ELIXIR\FORMS directory, and contains form
files.

Fonts folder

The Fonts folder represents the drive:\ELIXIR\FONTS
directory, and contains font files.

Graphics folder

The Graphics folder represents the drive:\ELIXIR\
PICS directory, and contains graphics files.

Documents folder

The Documents folder represents the     
drive:\ELIXIR\ DOCS directory, and contains docu-
ment files.

A document contains one or more form files.

Jobs folder

The Documents folder represents the
drive:\ELIXIR\JOBS\XGFOUT directory containing
JDT (Job Descriptor Ticket) files for transfer to an out-
put XGF printer.

Clipboard icon

Use the Clipboard icon as a temporary storage place
for forms while creating a document.
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User Files icon

The User Files icon allows you to access all DOS di-
rectories and files.  The icon also allows you to link
applications to files. 

Application icons

Application icons display at the right of the Desktop
and represent Elixir applications.  Depending on your
product and installation setup, various icons display
(such as ElixirFont, ElixirGraphics, ElixirDoc or Elixir-
Scan).

ElixirForm icon

The ElixirForm icon represents Elixir Forms Editor (or
Elixir Forms Editor for Highlight Color if you installed
either the Highlight Option or Plus). 

User Tools icon

The User Tools icon allows you to create and define
icons for DOS and Windows applications and batch
files. 

   

Diskette icon

The Diskette icon allows you to access and format a
diskette in your PC diskette drive.

Printers icon

The Printers icon allows you to access a local proof
printer connected to your PC.
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Scanners icon

The Scanners icon allows you to configure and start a
scanner connected to your PC directly from the Desk-
top (Elixir does not provide scanner software).

Dispatcher icon

The Dispatcher icon allows you to invoke DOS com-
mands or batch files in which you can embed replace-
able parameters.

Converter icon

The Converter icon allows you to convert font, form,
and graphics files to different formats by using simple
“drag-and-drop” mouse operations.

Trashbin icon

The Trashbin icon allows you to delete files.

Viewer icon

The Viewer icon allows you to view files for which you
have established an associated application.   
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 Using the Desktop

The subsequent sections of this chapter describe the
following basic Desktop operations:

accessing DOS
file management operations
converting files.  

Accessing DOS

The DOS menu allows you to run DOS commands
from the Desktop.

Selecting the [DOS Command] option or pressing
<Ctrl> + <D> displays a dialog box that allows you to
enter any standard DOS command.  Enter a DOS
command and select [OK] to clear the Desktop and
execute the command from the following directory:

from the root (drive:\) directory, if there are no
windows open on the Desktop

from the directory corresponding to the window, if
a window is open on the Desktop.

After the DOS command executes, the system
prompts you to enter any key to redisplay the Desk-
top.  
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Basic file management activities

The following sections describe basic Desktop opera-
tions that are common to all Elixir products.  These
operations include the following basic file manage-
ment activities:

file selection
dragging and dropping files
deleting files and folders
renaming files
duplicating files
overwriting existing files.

Selecting files in an Elixir window

Files display as icons in Elixir windows.  To display
files double-click on an Elixir folder and then double-
click on the appropriate Elixir, Input, or Output folder.
If you double-click on an Input or Output folder a win-
dow with more folders (representing different file for-
mats) displays.  

Double-click on the appropriate folder to display its
files in a window.  To select one file, click on it.  Note
that a selected file displays as highlighted.

To select more than one file (or multi-select files),
click on a file, then <Shift>click on other files.  The fol-
lowing figure shows several files selected.  
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Figure 3-2.  Selecting files

To deselect a selected file, <Shift>click on it.

To select a range of files, click on the first file in the
range, then <Alt> click on the last file.  The two files
and all displayed files between them display as
highlighted.

To select all files in a directory press <Ctrl> + <A>. Al-
ternatively, from the Selection menu, click on  [Select
All].

To unselect all files, press <Ctrl> + <A>.  Alternatively,
from the Selection menu, click on [Unselect All].
Clicking anywhere in the window other than on a file
also unselects files.

Press a character to select the first displayed file in
the window starting with the character.  Press the
character again to select the next file, and so on.  

DESKTOP BASICS
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File operations

With one or more files selected, you can perform file
operations by dragging and dropping the files to an
icon, by selecting an option from a pull-down menu, or
by entering a keyboard command.

Dragging files

To drag a selected file, click on it, hold down the
mouse button and move the mouse.  A square-
shaped dragging cursor displays in the window and
moves as you move the mouse.  The following figure
shows a dragging cursor example.

Figure 3-3.  Dragging 
cursor example

To drag more than one file, multi-select the files, then
click on any of the selected files while holding down
the left mouse button.  If you select more than one file,
a double cursor displays, representing multiple files.

Dropping files

To drop one or more files on a Desktop icon, select
the files, drag them to a position on top of the target
icon, then release the mouse button.  

If dropping the files on an icon is not permitted, an X-
cursor displays.

Figure 3-4.   X-cursor  
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Deleting files and folders

To delete one or more files from a window, select the
files, then perform any of the following actions:

Drag and drop the files on the Trashbin icon.

You cannot open the Trashbin to retrieve deleted
files.  Use the [Usage Switches] option in the Sys-
tem menu and select the [Confirm File Deletions]
option to avoid inadvertently deleting files.

From the File menu, select [Delete].

Press <Del> at the keyboard.

The Confirmation for Command dialog box displays
as shown in the following figure and shows the first file
in the list of selected files.

Figure 3-5.  Confirmation for Command 
dialog box

The Confirmation for Command dialog box contains
the following options:

Delete
Deletes the first file then redisplays the Confirmation
for Command dialog box for subsequent files.

Skip
Does not delete the first file, and redisplays the Confir-
mation for Command dialog box for the next file.  
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Confirm OFF and Continue
Deletes all the files without further prompting.

You can modify your Desktop setup so the Confirma-
tion for Command dialog box never displays when de-
leting files, and files delete without prompting (see the
Elixir Forms Editor Desktop User Guide for more
information).

Deleting folders is similar to deleting files, except that
you can only delete empty folders that you create.

Renaming files

To rename one or more files, select the files, then per-
form one of the following actions:

Press <F2>.

Click the right mouse button.

From the File menu, select [Properties].

Then type a new filename and extension in the dis-
played dialog box.

This procedure changes the external (DOS) name of
the file only.

The File Object Properties dialog box shown in the fol-
lowing figure displays the first file name in the selected
list.

The only option you can change is the file name and
extension.

   Figure 3-6.  File Object Properties dialog box
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See the “Overwriting existing files” section in this
chapter for more information.

Duplicating files

You duplicate a file by copying it to the same folder
and renaming it.  You can duplicate one or more files
in a single operation as follows:

Select the file or files you want to duplicate, then, from
the File menu, select [Duplicate].

The Object Duplication dialog box displays showing
the name of the first file in the selected list, as shown
in the following figure.

Figure 3-7.  Object Duplication dialog box

In the [into] option, enter the new file name and exten-
sion for the first file you want to duplicate.

To keep from copying the first file, select [Skip].

Select [Duplicate] to duplicate the file with the dis-
played name to the new file name.

The dialog box redisplays showing the next file from
the selected list.

If you duplicate a file in any of the Elixir folders and do
not specify an extension for the [into] option, the pro-
gram uses an extension appropriate for that folder.

See the “Overwriting existing files” section in this
chapter for more information.
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Overwriting existing files

When you copy or duplicate selected files, if files with
the same names exist in the target directory, a Confir-
mation for Command dialog box displays as shown in
the following figure.  The dialog box shows the name
of the existing file for the first duplicate file from the
selected list.

When you rename a selected file, if a file with the
same name exists in the target directory, a warning
message displays to inform you that a file with the
same name already exists.

Figure 3-8.  Confirmation for Command 
dialog box

The Confirmation for Command dialog box contains
the following options:

Overwrite
Overwrites the file, then redisplays the Confirmation
for Command dialog box with the next existing file in
the list.

Skip
Does not overwrite the existing file, and redisplays the
Confirmation for Command dialog box with the name
of the next existing file in the list.

Confirm OFF and Continue
Overwrites any existing files in the target folder with-
out further prompting.

You can modify your Desktop setup so the Confirma-
tion for Command dialog box never displays and the
program overwrites existing files without prompting
(see the Elixir Forms Editor Desktop User Guide for
more information).  
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Converting files

Using the Forms, Fonts, and Graphics folders and the
Converter icon in the Elixir Desktop, you can convert
form, font, and graphics files between Elixir-, and
other formats.  You can edit Elixir-format files in the
installed Elixir applications (ElixirForm, ElixirGraphics,
or ElixirFont) and reconvert them to the original or an-
other format using the Converter icon.

Before you perform conversion operations, you should
familiarize yourself with the Elixir folder structure.

Elixir folder structure

The structure of each of the four Elixir folder icons is
similar and described in this section.

Each Elixir folder icon contains three subordinate fold-
ers labeled Elixir, Input, and Output.

For example, when you open the Forms Folder icon
(by double-clicking on it), the window shown in the fol-
lowing figure displays showing the Elixir Forms, Input
Forms, and Output Forms folders.

   Figure 3-9.  Forms Folders window

Similarly, opening each of the other Elixir folder icons
on the Desktop displays a window showing subordi-
nate folders called Elixir, Input, and Output.

This Elixir folder structure allows you to edit, file, or
view form, font, graphics, and document files of differ-
ent formats.
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Figure 3-10.  Input, Elixir, and Output folders

Each Input folder is similar to an "in basket."  It
contains files you can convert to Elixir format for
editing or viewing by selecting them, then copying
them to the Converter icon.  See the "File conver-
sions" section of this chapter for more
information.

Each Elixir folder is similar to a "working area"
where you edit and view Elixir-format files.

Each Output folder is similar to an "out basket" to
which edited Elixir-format files write to after you
convert them back to the original, or another non-
Elixir format by copying the files to the Converter
icon.  See the "File conversions" section of this
chapter for more information.

To use Elixir folders for file editing, follow these steps:

1. Copy the file you want to edit or view to the
appropriate Elixir folder.

The Elixir Folder opens to display the Elixir, Input,
and Output subfolders inside.

2. Click on the Input folder.

The Input folder opens to display subfolders for
different file formats.

3. Click on the folder that corresponds to the
format of the file you are copying for editing,
or viewing.

4. Convert the file to Elixir format as described
in the "File conversions" section of this
chapter.
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5. Double-click on the converted Elixir-format
file to start the appropriate Elixir application
(such as the Elixir Forms Editor) and to load
the file.

6. Edit the file using the tools provided by the
Elixir application.

7. Convert the edited Elixir-format file to the
format you want.

The converted file writes to the appropriate Out-
put folder.

8. Open the Output folder and copy the
converted file to the desired location.  

File conversions

The simplest way to convert files is to use the Desktop
Converter icon.

The following example demonstrates how to convert
an Elixir form file to another format, however proce-
dures for converting font, and graphics files are basi-
cally the same.

1. Double-click on the Elixir Forms folder to
display the Forms Folders window.

To convert a font or graphics file, double-click on
the corresponding Fonts or Graphics folder.

2. Double-click on the Elixir Forms folder.

A window containing Elixir form files displays.

To convert another type of form format file, click
on the Input Forms folder to display a window with
folders representing different form format files.
Then double-click on the appropriate folder to dis-
play the file(s) you want to convert.

3. Select the file(s) you want to convert.

4. Copy the file(s) by dragging and dropping
them on the Converter icon.
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5. Specify the output format(s) to which you
want the file(s) converted in one or more
dialog boxes that display.

One or more output files with the correct file ex-
tensions generate and automatically write to the
appropriate Output folders. 
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4.  ElixirForm basics

This chapter describes basic ElixirForm operations.
For information on additional ElixirForm operations,
see the ElixirForm User Guide. 

For information on AppBuilder operations, see the
"Elixir AppBuilder for AFP" or "Elixir AppBuilder for
XGF" product documentation. 

Overview

ElixirForm is an interactive forms design tool that al-
lows you to create and edit forms in WYSIWYG (What
You See Is What You Get) mode.

A form created with ElixirForm is the static (or boiler
plate) component of a form, and contains elements
like lines, boxes, text, and images.  You can then
merge the static form with variable data for printing.

The static data adds meaning when merged with the
variable data.  For example, the following variable
data from a credit application form:

X 123-456-789 9876.23
X 985-234-980 11813.34

is more meaningful when merged with static data and
viewed together:

ELIXIR FORMS EDITOR GETTING STARTED GUIDE 4-1



With ElixirForm, you can see each static form element
as you add or revise the element.  With a desktop
proof printer, you can generate proofs at your desk,
and using the Converter in the Elixir Desktop, you can
compile your forms on your PC.

Also, you can use the Elixir Desktop to define a group
of forms created in ElixirForm as a multi-page docu-
ment (.DAT file).  You can view this file in ASCII for-
mat by opening it to start the Windows Notepad
application.

Product variations

Depending on the products you have installed, your
screens and options may differ from the figures dis-
played in this chapter.

If you have an Elixir forms application installed for
Xerox or AFP environments in addition to the Elixir
Forms Editor software, you can access form creation
features for that enviroment by switching to the appro-
priate toolset in the Desktop (selecting [Toolset] from
the System menu).  For example, after creating a
form in Elixir Forms Editor, you can:

switch to a Xerox toolset and load the form in
ElixiForm to apply highlight color to the form

switch to an AFP toolset and load the form into
ElixirForm to add OGL patterns to the form.

After modifying the form using an AFP or Xerox tool-
set, if you reopen the form in Elixir Forms Editor (a
Distributed toolset), form elements or features added
using other toolsets may not be supported or may dis-
play differently than expected.
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ElixirForm layout

The ElixirForm window contains the following
features:

a work area at the center of the screen

a Work Area menu bar above the work area

an ElixirForm menu bar at the top of the screen

a Message area between the menu bars

a Toolbox to the left of the screen, and a Toolbar
above the work area.

Figure 4-1.  ElixirForm window
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The ElixirForm menu bar allows you to access the fol-
lowing pull down menus:

File
System
Window
Help

The Work Area menu bar allows you to access the  
following pull down menus:

Edit
Tools
View
Options

You can pull down a menu in one of the following
ways:

Click on the menu.

Press the <Alt> key along with the underlined let-
ter in the menu.

Toolbox

The Toolbox displays to the left of the work area, and
provides tools for creating and editing the elements
that make up a form.  If you maximize the work area,
the Toolbox displays on top of the work area.
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Figure 4-2.  ElixirForm Toolbox

You can toggle between hiding and showing the Tool-
box by selecting [Tools] from the Window menu (or
pressing <F10>).

The following tools (from left to right) for creating and
editing form elements display at the top of the
Toolbox: 

Select tool; Line tool; Box tool; Text tool; Image tool.

When you click on a tool a short description of the tool
displays in the message panel and the options for that
tool display in the Toolbox.  You can select the options
for that tool by clicking on the corresponding icons.

The preview panel displays your option selection.  If
you select a box with a fill, the preview panel also dis-
plays the name of the fill.

Toolbar

The Toolbar displays across the top of the work area
and contains the digital ruler with blocks that show the
selected element, and the selected element coordi-
nates and size.  The icons in the Toolbar allow you to
show the graphic ruler, change the grid and view set-
tings, undo and redo operations, and show or hide the
Toolbox.  
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Figure 4-3.  ElixirForm Toolbar

Message area

When you position the cursor over an icon in the Tool-
box or Toolbar a description of the icon displays in the
Message area.  Operational messages also display in
this area.

Using ElixirForm

The following sections describe how to create a form
using ElixirForm.  In the process you will learn the fol-
lowing basic ElixirForm operations:

using the grid and rulers
creating form elements
editing selected form elements
using the undo/redo feature
modifying form elements
saving a form
proof-printing a form
loading an existing form.     
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Creating a form

This section guides you through the basics of creating
a simple form.  By following the procedures described
in this section, you can develop a sample form such
as the following credit application for a fictitious com-
pany called FedBank.  This section assumes that you
have installed Elixir demonstration files.  If you have
not already installed Elixir demonstration files, you can
do so by performing a [Custom] installation (see the
"Installation" chapter for more information).

         Figure 4-4.  Sample form  
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Using the grid and rulers

The grid and rulers allow you to be precise in your
measurements.

To turn on the grid, click on the Grid icon in the
Toolbar.

To display the measuring ruler, click on the measuring
Ruler icon in the Toolbar to toggle it on.

To display the current coordinates of the screen
pointer, the type of selected element, and the element
coordinates and size, click on the Digital Ruler icon in
the Toolbar.

You can also turn these options on and off by select-
ing an option in the View menu.

Creating form elements

The following section describes how to create some of
the elements such as  boxes, text, and images, that
make up a form.

Drawing boxes

Start your form by drawing boxes.

Click on the Box icon in the Toolbox (or  select [Box]
from the Tools menu).  The Box tool options display.
You can select the box positioning, shape, corner
style and radius, border width and style, number of
box splits, diagonals, and border  shading.

To draw the first box: 

1. Position the screen pointer in the upper left
corner of the screen where you want the box
to start.  Use the rulers to judge the margins.

2. Drag the screen pointer down and toward the
right of the screen.

As you move the screen pointer, the box in-
creases in size.  Continue moving the screen
pointer and watching the rulers until you have
"stretched" the box to the size you want.
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3. Release the left mouse button to complete the
box.

Your box outline becomes solid.

You can begin a box at any position on the screen and
stretch in any direction.

Adding text

To add text to your form, click on the Text icon in the
Toolbox (or  select [Text] from the Tools menu).  The
Text tool options display.  You can specify a font and
select text attributes.

To enter text:

1. Select a font from the fonts list in the Toolbox
preview panel.

The default font is the font at the top of the list.

2. Move the screen pointer in the work area to
the position where you want to begin entering
text and click the left mouse button.

3. Enter text from the keyboard.

4. Click the right mouse button to finish entering
text.

You can change typefaces by choosing a new font
from the font list.

Adding images

You can add an Elixir-format image to your form.

The screen version of an image has an .LW8 exten-
sion and is in the drive:\ELIXIR\PICS\SCREEN direc-
tory.  The printer version of an image has an .LP3
extension and is in the drive:\ELIXIR\PICS\PRINTER
directory.

To add images to your form, click on the Image icon in
the Toolbox (or select [Image] from the Tools menu ).
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To add the FedBank image to your form:

1.  <Ctrl>click on the load Image icon.

The Load Image dialog box contains images in
the drive:\ELIXIR\PICS\PRINTER directory with
.LP3 extensions.

Note:  Users of pre-3.0 versions of Elixir software
who only have screen versions of images (.LW8
files) can load their screen versions by clicking on
the Load Image icon; this displays a Load Image
dialog box with .LW8 files in
drive:\ELIXIR\PICS\SCREEN.  Note that to edit
an image, tile an image into a font, or convert to a
printer format of an image you must have the
.LP3 version of the image.

               Figure 4-5.  Load Image 
dialog box

2. Select FBLOGO.

3. Click on [OK].

4. Press and hold the left mouse button.

The image attaches to the screen pointer.

5. Position the image on the form.
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6. Release the left mouse button to lock the
image into place.

If you change your mind and do not want to place the
image, select [Undo] from the Edit menu or click on
the Undo icon in the Toolbar.  Use [Undo] immediately
after placing the image.  [Undo] works on the last form
element placed.

Modifying form elements

You can modify all form elements as often as needed.
This allows you to make similar forms by modifying an
existing form and saving it under a different name.
The procedures are similar for lines, boxes, images or
text.

Selecting elements

You must select an element to edit it.

1. Click on the Select icon, or click the right
mouse button in the work area.

2. Select the element you want to modify.

Handles display around or inside the selected
element.

If you want to select all the elements, click on [Se-
lect All] in the Edit menu.

To deselect all, click on [Unselect All] in the Edit
menu.

<Shift>click to select multiple elements.

Moving selected elements

To move a selected element:

1. Click on the Select icon.

2. Select the direction for moving: [Horizontal
only], [Vertical only], or [Free].  
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3. Select the element you want to move.

Handles display on the selected element.

4. Click on the selected element; the screen
pointer changes to a hand.

If the screen pointer does not change to a hand
when you place the cursor on the element, it may
be because the element is too small.  If this hap-
pens, press and hold the <Ctrl> key as you move
the cursor over the element.  The screen pointer
turns into a hand and you can now move the
element.

5. Drag the element to a new position.

6. Release the mouse button.

The element locks in the new position.

Copying selected elements

To copy a selected element:

1. Click on the Select icon in the Toolbox.

2. Click on the Copy icon.

3. Select the direction for copying: [Horizontal
only], [Vertical only], or [Free].

4. Select the element you want to copy.

Handles display on the selected element.

5. Click on the up or down arrows to select the
number of copies between 1 and 99.

Hold down the <Ctrl> key while clicking on the ar-
rows to increase or decrease the value by 10.
You can also backspace over the value and enter
a new value from the keyboard.
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6. Click on the selected element and drag it in
the direction you want to place the duplicate
lines or boxes.

Deleting elements

To delete selected elements, click on the Delete icon,
select [Delete All] from the Edit menu, or use the
<Ctrl> + <Del> hot key.  This command deletes all
elements on the page even if they do not display as
selected.

If you want to make an exception when deleting all the
elements, you can click on one or more element ex-
ception icons in the Toolbox.  This excludes the ele-
ment(s) from the delete operation.  For example, if
you have a form with text, boxes and lines on it, and
you want to delete the lines and boxes but not the
text, click on the Text icon then select [Delete all] from
the Edit menu.  All lines and boxes delete, and only
text remains.

Editing selected form elements

When you select an element, you can use the icons in
the Toolbox to change the properties of the element.

To change the properties of a selected element:

1. Place the screen pointer on the selected
element and click the right mouse button.

The tool options for that element display in the
Toolbox.

2. Click on a tool option to change the
properties of the selected element.

For example, click on the Box icon to change a
selected square to a rectangle.

3. Click the right mouse button again to return to
select mode.

To change the coordinates of a selected element:

1. Place the screen pointer on the selected
element and click the right mouse button.
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2. Place the cursor in the coordinates box in the
Toolbar and enter the new coordinates.
ElixirForm will not accept coordinates that
exceed the page limits.

Use the <Del> key to delete the whole
number.

Use the <Backspace> key to delete only the
last number.

3. Click the left mouse button to accept the new
coordinates.

Using the undo/redo feature

ElixirForm allows you to undo or redo an operation.

To cancel the most recent operation:

Click on the Undo icon in the Toolbar (or select
[Undo] from the Edit menu). If you want to cancel
a group operation, ElixirForm undoes the opera-
tion one element at a time.

To cancel the most recent [Undo] operation:

Click on the Redo icon in the Toolbar (or select
[Redo] from the Edit menu).

Saving your form 

When you complete your form, save it for future use.

To save your form:

1. From the File menu, select [Save Form] or
press <Ctrl> + <S>.

The Save Form dialog box displays showing the
contents of the forms directory.

ELIXIRFORM BASICS

4-14 ELIXIR TECHNOLOGIES CORPORATION



             Figure 4-6.  Save Form dialog box

2. Type a filename in the File name option. You
do not need to type an extension.

A .ELX extension automatically adds to your form
name and your form saves in the
drive:\ELIXIR\FORMS\ELIXIR directory.

If you plan to convert your form to other formats
you should save the form with a maximum six-
letter file name.  Longer file names truncate upon
conversion and could result in overwriting existing
files.

3. Click on [OK].

After you name the form, you can press <Ctrl>+ <S >
to perform a quick save.

If you want to save an existing form to a new file, se-
lect [Save Form As] from the File menu (or press
<F7>), and type a new filename in the Save Form as
dialog box and click on [OK].  A .ELX extension auto-
matically adds to your file and saves in the
drive:\ELIXIR\FORMS\ELIXIR directory.  
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Proof-printing your form

To proof-print your form, select [Print] from the File
menu.

Select your proof printer and other print options from
the Print dialog box and click on [OK].  Your form
prints on the selected printer.

Loading an existing form

To load the form you just created the next time you
start ElixirForm:

1. From the File menu, select [Load Form].

The Load Form dialog box displays.

    Figure 4-7.  Load Form dialog box

2. Highlight the name of the form file you want to
load and click on [OK].  You can also
double-click on the form filename.

ELIXIRFORM BASICS

4-16 ELIXIR TECHNOLOGIES CORPORATION



Glossary

This glossary contains a basic list of the terminology
used in this guide.

application
Any program you run on your PC.  Icons represent
Elixir applications on the Elixir Desktop.  If you did not
install an Elixir application on your PC, its icon does
not display. 

arrow 
The screen pointer used for selecting objects.

button
An area on the screen that responds when you click
on it.  For example, each dialog box has an [OK] but-
ton that accepts your entries when you click on it.

click, on an item 
To momentarily press and release the left mouse but-
ton with the screen pointer on an item.

close 
To exit from a window, dialog box, or the Desktop.

close box 
A small white box at the left of a window header and
at the left of the menu bar.  Clicking a close box on a
window header closes the window.  Clicking a close
box on the menu bar exits the Desktop.

command button 
A button in a dialog box that confirms or cancels an
action when you click on it.  The [Cancel] button can-
cels the command.  The [OK] button confirms and
executes the command and saves the information you
specified in a dialog box.

Converter icon 
The icon that converts font, form, graphics, and docu-
ment files.
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cursor 
An I-shaped screen pointer used when entering text in
a dialog box.

Desktop 
The Elixir Desktop working environment, consisting of
the menu bar, the screen area, and the icons on the
screen.

dialog box
A rectangular box that displays and requests informa-
tion.  You enter information in fields in the dialog box,
and normally confirm your entries by clicking on an
[OK] button or by pressing <Enter>.

dimmed options 
Dimmed options are menu options you cannot choose
because they do not apply to your current selection.
Also called grayed options.

directory 
A list of hard disk or diskette contents.  Folder icons
represent Desktop directories.  You can view folder
contents pictorially, alphabetically, by icon, by size, or
by date.

Dispatcher icon 
The icon that stores and invokes a number of DOS
commands.

DOS  
Disk Operating System, the collection of programs
that gives control of a PC's resources to the user.

double-click 
To press the left mouse button twice in rapid
succession.

drag
To click on an item and move the item with the mouse
while holding down the left mouse button.

drag and drop 
Used to copy an object as follows: click on an item on
the screen, hold down the left mouse button, move the
mouse to move the screen pointer to an icon, and re-
lease the mouse button.
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drop 
To release the mouse button after dragging an item to
an icon.

Elixir folders  
The folders represented by the four top left icons on
the Desktop: the Forms, Fonts, Graphics, and Docu-
ments folders.  Each of these folders contains an
Elixir, Input, and Output folder.  See the “Elixir folders
structure,” section for more information.

extension 
The three characters following the period after a file
name.  In the Desktop, an extension identifies the type
of information in a file.  For example, .ELX indicates
an Elixir format form file. 

fast keys  
See the "Keyboard shortcuts" appendix.

file name 
The name of a file.  The Elixir Desktop uses DOS file
naming conventions.  DOS file names consist of a
base (stem) name containing up to eight characters
and an extension of up to three characters.

folder icon 
The Desktop icon representing a DOS directory.
Folders allow you to quickly organize information on
the Desktop.

format 
To prepare a diskette so it can hold information.  For-
matting a diskette erases the information on the disk-
ette.  The Elixir Desktop allows you to format
Xerox-format diskettes.

highlighted 
A highlighted icon indicates a selected icon.

icon 
A small symbol on the Desktop that represents an ap-
plication, a file, a folder, or a peripheral device.

invoke
To start an application.  Also referred to as run. 
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ELIXIR FORMS EDITOR GETTING STARTED GUIDE GLOSSARY-3



keyboard shortcut 
Also called a Fast Key.  A one- or two-key combina-
tion that allows you to execute an option without using
the mouse.  Keyboard shortcuts display on each
menu beside the name of the option (see the “Key-
board shortcuts” appendix).

menu 
A list of options from which you make a selection to
perform an action.  A menu displays when you select
a menu title from the menu bar or from a window
header.

menu bar 
The horizontal bar displayed at the top of the Desktop
from which you access pull-down menus.

menu titles 
Text that identifies a menu, displayed in a window
header or on the menu bar.

message area 
A bar just below the menu bar that displays error mes-
sages or information about the activity you are
performing.

mouse button 
A button on top of the mouse.  The Elixir Desktop sup-
ports most actions using the left mouse button. Use
the right button to display icon properties and Help.

multi-select 
Selecting more than one file or icon by shift-clicking
on them.

open a folder, Elixir file, application, or peripheral
device:
1.) Opening a folder icon displays a window showing
the contents of the folder.  2.) Opening an Elixir file
icon starts the application that created the file and
loads the file .  3.) Opening an application icon starts
the application.  4.) Opening a peripheral device dis-
plays a properties dialog box allowing you to set the
device parameters.

option 
A word or phrase in a menu that you can select.
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peripheral (device) 
A printer, scanner, or diskette drive connected to your
PC. 

point 
To move the mouse so the screen pointer (in most
cases an arrow) rests on the desired item.

Printers icon
The icon representing a proof printer connected to
your PC.

pull-down menu 
See menu.

run 
To execute or start an application.  Also referred to as
invoke.

Scanners icon  
The icon representing a scanner connected to your
PC.

screen pointer 
A pointer shaped like an arrow that displays on the
screen, and which you can move by rolling the mouse
on a flat surface.

scroll 
To move a directory list in a window so you can view
different parts of the list.

scroll bar 
A bar displayed on the right side of some windows
used for scrolling.  The scroll bar contains a scroll ar-
row, + and - buttons, and a slider bar that moves
within the scroll box.

select 
To click on an object or menu option.  A selected item
appears highlighted.

shift-click 
To click on an object while holding down the <Shift>
key.  Usually used to select multiple items.  
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slider bar 
A bar in the scroll box at the side of some windows
that scrolls items in the window when you drag it up
and down.

Trashbin icon
The Trashbin icon is in the lower right corner of the
Desktop and represents a receptacle for items you
want to delete.  You delete a file by dragging it to the
Trashbin icon.

unselect/deselect 
To cause one or more selected (highlighted) icons to
not be selected any more.  The quickest way to do this
is to click on another area of the Desktop.

User Files icon 
The icon that links applications to files.

User Tools icon 
The icon that allows you to create and define icons for
DOS applications and batch files.

wildcard character 
A character in a file name, usually an asterisk (*), that
specifies a matching set.  For example, *.FNT repre-
sents all files that end with the .FNT extension.

window 
A rectangular area on your screen in which you view
information, such the contents of a folder.  All win-
dows contain a window header.  Some windows have
scroll bars along the right side. 

window header 
The top of a window that displays the DOS directory
corresponding to the window contents.  Some window
headers also show a close box and a number of menu
titles with pull-down menus.
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A
Acrobat Reader, docu-
mentation, 1-10
application icons, 3-5

B
Bubble Help, 1-8

C
Clipboard, 3-5
Context sensitive Help,
1-9
conventions

display, 1-5
mouse, 1-6
typographical, 1-5

Converter icon, 3-6
converting files, 3-15
creating a form, 4-7
customer support, 1-2

D
default installation

first time, 2-9
deleting files and fold-
ers, 3-11
Desktop

applications, 3-5
Clipboard, 3-5
converting files, 3-15
DOS access, 3-7
ElixirForm basics,
4-1

file management,
3-8
folder structure,
3-15
folders, 3-4
icons, 3-3
installation, 2-1, 2-7
layout, 3-2
menu bar, 3-2
overview, 3-1
sub-windows, 1-15
using, 3-7
window, 1-14

Dialog box Help, 1-9
Diskette icon, 3-6
Dispatcher icon, 3-6
documentation

accessing, 1-10
Acrobat Reader,
1-10
directory, 1-10
navigating, 1-11
printing, 1-13
scrolling, 1-12
using, 1-10
word find, 1-11
zoom in/out, 1-12

Documents folder, 3-4,
3-5
DOS, accessing, 3-7

E
Elixir applications

cautions, 1-16
conventions, 1-5
exiting, 1-16
Help, 1-8
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modifying forms, 4-11
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on-line documentation
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Acrobat Reader,
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directory, 1-10
navigating, 1-11
printing, 1-13
scrolling, 1-12
using, 1-10
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Output folder, 3-8, 3-15
overview
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ElixirForm, 4-1

P
Printers icon, 3-6
printing

documentation, 1-13
proof-printing a form,
4-17

Q
Quick Help, 1-8

R
registering software, 2-2
requirements
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software, 1-4
system, 1-4

S
saving a form, 4-15
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sub-windows, 1-15
support, customer, 1-2
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T
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User Tools icon, 3-5

V
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